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INTRODUCTION

How to use this course unit

This course unit is not a manual but a combination of theory and workshops with which
to learn the programme on a 1-to-1 basis. Every mouse-click and every entry is
described in detail, providing you with a teaching resource that lets you learn the basics
of the programme by yourself. Each chapter provides explanations, information, and a
workshop to practise the functions. To enable the workshops to be completed
smoothly, the explanations should be read through very carefully. The order of the
chapters should not be changed because each workshop is based on the previous one.
The ELITECAD installation media contains examples stored as an ELITECAD file,
enabling problematic places to be reviewed on the finished project.

Conventions used in this course unit
The start and end of a workshop are marked as follows:

Functions are written in block capitals. The corresponding icon also appears for new
functions.
FUNCTIONS (BLOCK CAPITALS)

u

=

Functions can be accessed directly using icons (buttons). The functions are grouped
together in tool bars or under tool management.

Tools x
Search O
Help lines
: : A -
* Main functions v x R R S
= " P - -
O F 33 o B oo | §ho ke

[Enter]

Function keys on the keyboard appear within square brackets.

Input values (bold)

Input values must be entered using the keyboard. When the text is entered in the input
line, it must be confirmed with the [Enter] key.
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Launch programme

YVYYY WORKSHOP

1. Launch the programme.
ELITECAD ME15 icon is located on the Desktop.

ELITECAD ME15
E

Double-click on the icon.

R | N

IMEGHANICS 15

METRIC GmbH. (1993 - 2021

WORKSHOP END
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USER INTERFACE
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The appearance of the user interface can vary, depending on the installation and screen
resolution.

Title line

File: <D:\EliteData\projects\en_uk\Samples mechanics\Samples-2D\5mp01_2d.d> ELITECAD - [Design model]

The title line of the programme shows, which file from which path is opened.

Menu bar

File: <unnamed.d> ELITECAD

File | Edit View Insert Draw ME-Objects Modify Lay-o

O e cin ] Y BB o
& losd.. Ctrl-0
1 @ Load work copy...
Show..
Recently loaded files »
Import » P2 oxrowe..
N o
[ = Cires | B 1GES-.
Ry seveee. o | B M
G save work copy Ctriewy | % Point doud..
Save for transfer... g Ternin data..
Export v BB Losd vDAFS..
Bl send B, o0
1 g sTep.
Create archive =
Load archive b G2
=R Ctrlep & camava.
&) ZoomPlat Ly ST
= Solidworks...
E Save PostScript file & solidworks
=2
Ll severorsie &
¥ i
(= Parasolid...
AP et AtsFa [
(- = I | B Frok.
HUDTee &
Lay-out @ s
pos %/ r.ﬁ 1123 B sketenup..
& 30s..

AP o gt

The menu bar with opened and extended "File™ menu. Here the submenu “import” is
opened.
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Toolbar

Toolbars offer rapid access to the most important commands. Many of the symbols or
icons can also be found with the same meaning in the relevant menu entries.

Tool management

In tool management, you will find a number of different toolbars combined. These can
be opened and closed to suit your requirements, enabling you to bring together a
number of functions in a small space. The order in which the bars appear can be
changed and you may also add your own new bars.

Property bar
’.é) E 1 — ’ 4 @ 10,0/ - :/:‘ Circle by centre pnt. and r.

The property bar displays the properties of the active part or for a manipulation to be
performed. There are properties bars for manipulations, elements, hatch patterns,
dimensions, text, 3D solids, and components. The example shows the properties bar
of the wall.

Input assistant

The input assistant consists of additional functions that vary according to the
function selected. The functions for input assistant can also be displayed on the
cursor using the [Tab] key.

Not every function has these extended functions. In principle these are the create
functions and the manipulations on the handle.

Example of the polygon drawing function with the additional functions for drawing a

polygon:
Palygon f/\ FEa YRy }:\
LA
= [l g
2 000 9
A 000 7
o 228657 7

Example of manipulation on the handle of a polygon:

%ol
g
[S=NSSEE S
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CAD input window

AR CEFEINEG 9090 DY #1252 %5 '8+ LEREE
7

B @ pesign model

1 ] s © mm

The input window contains the image properties, the information line, the input line
and the status.

Screen properties

These commands are fixed. They control how the data is displayed on screen. Zoom
factor, cut-out, imaging, etc.

Information line
This line contains commands as to what you must enter or determine within a function.

Input line
You use the input line to forward information to the program. This information could
be texts, coordinates or, in event of prompts, confirmations.

Status
@ @ Design model

1:5 - | mm * | A3
Here you can select representation mode, scale, units and the page format.
Status line

Ready 20 GPU 1.7GE free MUM

The status line is the lowest line of the program. The left-hand area shows
confirmations that e.g. the work copy was saved successfully.

The current position of the working plane is shown on the right. If no changes have
yet been made, the value "Z0" is displayed. "Z" stands for the axis, "0" indicates the
height on this axis.

View management View x

In complex projects, managing the various drawings and = -B& ‘: &
views is a key issue. This administration becomes even 4P El

Design-model views

more interesting if it should also include dependencies. Views
Thanks to the drag & drop technology in ELITECAD, it is Sections

Plan views

possible to handle almost any number of views with their = ;.

dependencies very intuitively. Plots
Layout templates

Reference

www.elitecad.eu 7
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Layer management Layer x
ELITECAD uses the very powerful and extensive *& % 8#-°
Default - X EFd

classification with patterns, groups, classes and levels. This —
arrangement can be used extremely productively, but @
requires intensive discussion on the part of the user.

The layers are an additional simple linear structure.
Projects can now be processed with both structures in
parallel, so that users can choose either one or the other
structure.

|internal production
external production
purchsed items
stock items
standard parts

unit 1

unit 2

steel construction
maunting
surrcundings
terrain

sheets

profiles

brackets

pipes

support

girder v

Drawing structure

In addition to the layer and classification, an ELITECAD
drawing can also be structured hierarchically with the help
of assemblies. An assembly defines a combination of
ELITECAD components (pattern and objects) into a logical |“‘? | |
unit.

A component can be a single pattern or an object that is composed of several patterns.
Obijects are especially 3D objects that are created using several patterns (e.g .: 2 view
bodies, Boolean operations).

CR G NI R I I I I I C I I )

An assembly can also have sub-

Drawing structure X 3
BOR LD assemblies. Thus, a structure tree
4[E] Design model can be formed, the depth of which
4(fp ® Pump : H
o e is arbitrary. _
fl = Cosecover The top assemblies are also known
B as main assemblies.
b & ® (without name) (31 If a new assembly is created, it must
‘®§g"§:‘:j be assigned a unique name. If this is
[ ﬂ@ Connection (3x) not the Case, a. number |S
‘ %; e 2 automatically added to the name at
(h ® Gasket the end.
m& Gasket
m& Gasket

4(Fp ® Screwing
[ ﬂ & Cylindrical screw (8x)
[ ﬂ@ Hexagonal nut (8x)
[ ﬂ@ Screwing [(8x)
b [k = Washer (16%)
A=
b
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Infofenster

Im Infofenster werden lhnen Informationen angezeigt, wie z.B. Auflistungen von
Elementwerten, GrolRen, Strukturen oder Informationen beim Einlesen von Daten.
Mit einem Doppelklick ins Infofenster wird es in den Vordergrund geschaltet.

Info window v ax @
3
=3
=4

file copy successfully =

Load testing successfully ended %

Info balloon
The messages of the info window can also be displayed in the info area (task bar) of
the operating system.

Pre-condition:
Activated option "Show notifications as info balloon™ in ELITECAD

Settings> Options> System> User interface

ELITECAD - Info
file copy successfully

Load testing successfully ended
ELITECAD 15

www.elitecad.eu 9
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DRAWING LINES

The basic functions for drawing lines are the individual line, the polygon, and the
rectangle.

= Elements

S NOMR
@ ek ¢
Ao S

When you select one of these functions, the properties bar of the elements appears.
% = —, [¢2¢ B [ ]AD e
The line is composed of the line and pen type.
Line types
There are 9 "fixed" line types available. Other additional line types can also be defined.

=10 ) <
1 10 l ! 2 ! rl

1

12
4 ________

13
5 ______
o 14
;s
g ————— —— 16
§ 17

Pen types

You can choose from 1024 differently coloured pen types. The selection opens with a
single click on the colour square. There are different colour squares sorted by pen
number, colour values or grey values.

74

< MNCS.. 0-127 >
HN A\ EEE N

Pen view... Greyscales... Y

50
- |

S|

517
HE ~ | | = =
EEE ol N Gw= b= R
EEEEE S®_ | . | m -
- I . A

S8 Pen view... Colour values...

587

304 305 306 307 308 309 310 n
58

32 313 314 315 316 37 318 319
5100

320 321 322 323 324 325 326 327

El Bl E1 B3 E E

The line appears in the relevant colour on the screen. A pen thickness is assigned to
every pen colour.

www.elitecad.eu 10
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In the colour properties the screen colour, print colour and pen thickness per pen
number can be adjusted. If you are not yet familiar with the pen numbers and the
corresponding pen thickness, you open the screen by selecting SETTINGS >
COLOUR PROPERTIES from the menu.

Colour properties

Col. scheme | Standard ~ New

(O Lines black / Planes greyscale Save

(® Line coloured / Plane coloured

() Line black / Planes coloured Delete

Import...
[ Print line width P

Line gauge scaling Export

MNumber Colour Print colour Line gauge &

£ [ | ] 0.

&£ L] [ | 07

&£ [ | [ | 05

&3 ] [ ] 0.35

&#a | [ | 0.25

&5 [ [ ] 0.18

&6 | [ | 0.13

47 O u 0.1e .
Cancel

Pen 0 is only displayed on the screen; these lines do not appear on the
printout.

Cursor

The cursor consists of the marker, the crosshair, the arrow and, if a point is entered,
the value field. The marker always specifies the last position. As soon as the cursor is
at right angles to the last position, temporary reference lines appear with a display of
the angle. This means you can check whether you are drawing at right angles.

+—— Temporary help lines
Angle
Snap mode

0.0 Crosshair
#% 1 256 & Arrow

57266
e 57266 7 o 48441
< 000" -

|
|
| I 38770
| e o 62829
| - 4 3810°
| -~
| /
| -
- B
= 720
'\ =t o
Marker N 2B

<X 0.00 ¢

The cursor responds as soon as it is positioned near a capture point and indicates the
type of capture point by means of a symbol.

www.elitecad.eu 11
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L 0.00
—F A -
t  om T BH
=  om 0.00
o 000 | 30539°
e 0.00
=r 27000 °

Temporary reference points and lines

When drawing, references to a geometry already created often need to be made.

You create a reference point by hovering the cursor briefly over the desired point; the
programme displays the reference point as an orange cross.

Instead of hovering over the point you can press the [Shift] key.

The temporary reference points are deleted again after every click. The points can be
deleted manually the same way they were created.

Drag the line until it is perpendicular below a corner

]
- = 0.00
- ¢t 000
- - 0.00
x 27000°

b ,0.0%,270.0°

When dragging the cursor to a position — N 0.00
. 1 0.00
perpendicular below the temporary reference
point, a corresponding temporary help line o Ngﬁ .
appears and the symbol for "Perpendicular” is % g
shown.
Drag line into the extension of an existing line
"_'I& &9
- — LT
- 21 j4a48
- 1 16045
= 0.00 = 6422 *
N 0.00
0.00

11.31°
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A new line must lie parallel to an existing line.

o
- < 17133
-~
- g 59.98
- - e 198 41
/ -~ <X 026 -
2
>4 §
e
K\\ .J'/
e
Y
o 12471 g
£y s
o 14634
. 32845°
Draw a line in the middle of two points.
ﬁ—H 0.0 — —
// °l3 oo
g :; 422? ’ b.,90.0%,270.0°
A ] /%% s
// - o®l1 oo
-
g ______ ,0.0°,270.0° -~ :; 5:% )
2 — FER TN _
° 3 om - g
e 0.00
<€ 27000 °

If, when drawing, no temporary help lines or reference points appear,
this means the functionality has been deactivated or changed in the
configuration settings of the autosnap mode.

Configuration of autosnap mode:
Right-click > Configure autosnap

Configure autosnap
Auto snap

Use extended auta snap mode
p
Snap

Subdivisionpoints
Connection points
Endpoints
Intersection points
Middle of element
Mormal

Tracking

Orthogonal
Extension

Middle of 2 points
Parallels

Marrmal
Tangent

Halving of an angle

Centre circle

[ Text reference points
[[]Tangents

Elements

Grid points

Enter polygon

Multiple angle:

[ Additional angle

Mew

Delete

www.elitecad.eu
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DRAWING A POLYGON

A polygon consists of interrelated lines that can be selected together with a single click,

including subsequently. When drawing, ensure that you only ever draw interrelated
lines in a polygon.

Draw the following polygon:

PG

1. Start with the DRAW function.

N

This function is found under Tools > Elements.

Tools * 3 x
search O

Auxiliary-lines
Elements

JIN|IODE B ®
Gk agR /7 A
oS5 &

www.elitecad.eu 14
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2. Start with the perpendicular line. Move the cursor into the upper left of the screen
and left-click on the start point P1.

3. Move your cursor down (no need to keep either mouse button pressed). As soon as
you move the cursor vertically to below the starting point, a temporary help line and
the angle will appear.

F"I@
|
!
270.0%
g — 0.00
= B s
o 64420
2 27000°

Once you are at roughly the correct distance, left-click on the location P2 to confirm
it.

4. The next element is horizontal. Move your cursor to the right. Once again, the
temporary help line and the angle tell you whether you are orthogonal. When you have
reached the correct distance, confirm the location P3 by left clicking.

% _________ 0.0°
< 173962

P3%2-lr o
o 173962
£ 0m°

5. The next point, P4, is located in the middle of the two points P1 and P3. You cannot
snap this point directly. Instead, you require help points known as temporary reference
points.

P1

P4
A

P3

www.elitecad.eu 15
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Set the two reference points BP1 and BP2 positioning your cursor briefly over points
P1 and P3 until an orange cross appears.

% - | 0.00
= i 0.00
o 0.00 [~ __
= wa 5
o

157.84 * 0.00

? 0.00

=7 0.00

<C  180.00 °
The middle point can be caught between two temporary reference points.

Move the cursor towards the centre until the catch symbol appears, indicating the
centre of 2 points. P4

oe®

6. The next element is perpendicular to the slanting line and ends on the base line. This
time you need to add a temporary reference point BP1 to the starting point. Move the
cursor to the intersection point of the temporary help line and the base line. The symbol
for perpendicular and for intersection point P5 appears on the cursor.

b
‘ —ﬁf—} 0.00 i
1 D.00
e 0.00 P5 R%x ‘; ggg
180.00 °© '
* A 0.00
a0 27T

www.elitecad.eu 16
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7. The next element is a curve. In the input assistant, additional drawing functions such
as tangential arc, curve through 3 points, etc. are available.

For the input assistant to appear above the value field, the [Tab] key must be pressed.
Select the function TANGENTIAL ARC.

A ain

T
465316

%

i

e 67053 g-

<£ 13636° 4
o

Set the temporary reference point BP1 and the end point of the circle vertically above
it. P6

P6|s0.0°
D.00

Ed
Py 90
0.00 - 7 38580
‘ ® 0.00 T = 9D00°
0.00
147.03 * T "{

8. The next element is parallel to the existing slanted line and ends vertically above
P3.

& el

The one reference point BP1 is located on P3, the other BP2 somewhere on the slanted
element.

0.00

0.00

0.00
160.66 °

0.00

0.00

0.00
33715 °

www.elitecad.eu 17
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Set P7 parallel to BP2 and vertical to BP1. The symbols for perpendicular and parallel
should appear on the cursor.

9. The last element ends in the middle of the slanted line. You can set this point directly
without reference points. When doing so, make sure that the symbol for centre of
element appears on the cursor. P8

A5

10. To finish the polygon, click again on P8.

To finish a polygon, close it by clicking on the start point, double-
clicking on the final point or by cancelling the function > [Esc] key or
another function.

11. To remove the lines from the screen, open a new file.
[

MNew drawing X

Should the active drawing be saved?

I Yes II Mo I Cancel

www.elitecad.eu 18
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POLYGON VIA ENTRY OF COORDINATES

Very often it is not possible to catch a point, rather a certain line length is predefined.
These lines can of course be constructed with help lines. It is much easier and more
efficient to enter a polygon using coordinates.

Values field

Lengths can be entered directly in the values field. To move to the values field, press
the [Tab] key. In the values field the x value (horizontal), the y value (vertical), the
direct value or the angle can be entered.

v value

#

TR
o

o =] (0 oo

in =] e

= e e

direct value

P x value

G 5
1 000
o moo g Angle
4 18000° :

" 10000 4
10000 g
14142 g
15007

"

ﬁ&ﬁﬁ}

minus

Value on element or help line

If, when a value is entered, the cursor is on an element or a help line that passes through
the marker or a temporary reference point, the entry switches to the direct value and
you need only enter the distance, without worrying about the angle or the minus range.

v Temporary Symbal indicating the refer
.H Marker
reference ‘%~ point from where the distance
E point will be measured
Snap mode | 270.0

— -

e Shap mode

www.elitecad.eu 19
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This sequence of lines must be created by entering coordinates.

P1 P4

P5
P&

P2 P3

1. Start with the DRAW function.

N

2. Move the cursor on any random point and left-click on P1.

3. Move your cursor below P1 until the temporary help line 270° appears, press the
[Tab] key to access the values from the value field, enter 600 as direct measurement
and confirm with [Enter] > P2. Provided the cursor is located on a temporary help
line, the direct mass will be transferred to the help line in the direction of the cursor.

P1

% _nﬁmh

| 270
= 000
ey 46522
|
x 2/000°

o

4. To create the next point you proceed in exactly the same way except that you move
the cursor onto the temporary 0° help line. For the direct dimension you enter 1600 >
P3.

= 1600

< 0.00 *

v

www.elitecad.eu 20
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5. Entry of coordinates also works from a temporary reference point. Set a reference
point on P1, then move the cursor to the right until the 0° help line appears, press the
[Tab] key, enter 300 as direct measurement and confirm with the [Enter] key > P4.

. I
P1 300 pmmm
b,ORL 39882

- B 0.00 R 0.00
(] L .

! gg

= : - 0.00*

€ 15277° —% £ ,_]

6. Instead of using the temporary help lines, the location of the new point can be
determined by entering an x and a y value. Ensure that the cursor is not positioned over
a temporary help line, press the [Tab] key and enter 0 as x value and -300 as y value >

P5.
P aY¥aYela
7& Py DOD A
E\m 3004
2 26710 9
‘ = |

50.00 *
-

7. Enter the angle 45 ° into the value field and lock it by clicking on the padlock. The
colour of the padlock changes to red. The cursor is now fixed on the 45° ray. Also set
the x value to -300 and confirm > P6.

ﬂnﬁﬂn ﬁ’.{\mmﬁ

'3

I 413. 21
Ic':‘ 532.85 55'2 85 9
<L 45.00 ° 45 00° 49

8. Finish the polygon by clicking again on P6.

-

1 0.00
! 0.00
<X 000 °

9. To remove the lines from the screen, open a new file.
O

www.elitecad.eu 21
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AUXILIARY LINES

The auxiliary lines in ELITECAD are a tool to create an auxiliary drawing with help
lines of which you can later on draw a geometry.

The auxiliary lines remain with the temporary help lines that you have already learned,
until you delete them.

The auxiliary lines are consisting of lines and circles and are created using the
following tool bar:

Straights/circles
Tools * & ox
Search j o

Auxiliary-lines

S N M P i
R ;}zi e el
&by or

Create the following auxiliary structure with the auxiliary lines.

P,
[
IFl
A
11

SEREE
11

,

LY

===

rmd -
1n !

1

x

1

1

1

-l

}
+-

-
~
":""f'l'"‘""'l'
i b
-
1
-

.
¥
Lboodichoohodoooadhoo
F=spen Smre-=3

1. For one horizontal and one vertical help line as starting point use the function
STRAIGHT WITH PRESET ANGLE THROUGH POINT.

)

You can enter multiple angles, separated by a comma.

<] :

Click in the centre of the working area.

www.elitecad.eu 22
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2. The vertical help lines have 4 times the gap of 200 cm. Select the function
PARALLEL STRAIGHTS.

n

Set distance 200 and 4 copies.

Click NEXT to the line to which the help lines are to be created. Depending on whether
the vertical or the horizontal help line is closer when you click, the lines will be created
accordingly.

i
Focooooallccooooooooooo
EE e e
L Lo T T
-

fmm s m -y m————

3. The horizontal help lines have different gaps. They can be created one after the other
or all gaps can be created together at once, separated by a comma. Do not forget to
reset the number to 1.

Click above the horizontal help line, which can lie quite a bit outside, so that a vertical
help line is not suddenly closer when you click.

————
————

-
L

-

1
1
1
1
1
1
1
1
1
1
1
1
L
1
L

B
[
L cccoooopmooooooooooood
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
._______1_1_____
1
L e e
EEE LR e B
A S .

4. The next help line has an angle of 35°. Access the function STRAIGHT WITH
PRESET ANGLE THROUGH A POINT and set the angle.

fii

[ I T B T | ]

Pl e

.
_____________ L S P
------------ R R P R R e

[ T I | o

Pl i

o

T L

1 L o fle ]
"""""" T 'L‘f‘k'?—» 0.00

1 1 ~1

LA PR ow

1A% 0 e 0.00

AT 1 1 .

T
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5. The next help line is perpendicular to the 35° slanting help line just created. Access
the function TANGENT NORMAL ON LINE.

X

First, determine through which point the auxiliary line is to pass and then to which line
it should be perpendicular.

Through which point? Perpendicular to which line?
1 1 1 1 1 ] 1 [ 1 1 i
RN . R 5
. L
............. L R e L. S By By R Coooooooooo S e oo
------------ e R nRODT G e L E R L PP ETE A SE S A EECT PP EPT PR r e
[T T I T | - [T T T Y PR
A :::::n,—ﬁ. ——
1111 0.0% L
D ST TTowme | TS :":":"."1',@"""%% 1%
ettt st £ it I Y 1. B el i i 2 e -3
[ I ) | LI R 1 b |
[ W 0.00 I A £ ¥
1 11 1 1 1 | e | 1 1 -
(L = 18166 [ T "
AT 1o 1 AT 1o 1 LY
Lo 0 L0 L P I ~

6. The final auxiliary line is a help circle. The circle must be at a tangent to a straight
and pass through two additional points. Start the function CIRCLE BY 3 POINTS OR

TANGENTS.

ks
-

Tangential to the first vertical auxiliary line

N J
1 1 h 1 -
Y o
L %
............... = coooooooooocSooood
------------ A Eorr o
[ R B Y o
"R T LY .
;l(gl <  186.00
------------- - bR 906 96 - - - - === ===~
"""""" Amdmmer 211406 | mmmmmmmmmmees
- ,.{;C 27505 ° >,
3 B
o
PR
1st point 2nd point
IR I R B | ] [T T T B | B
LI LT | - 11 Rog 1 -
(| Iavgy 1 ,ﬂ I T B S B | /f
. . L -
-.-.-.-.-.-.-.-.-.-.-.-.-JI --.:--.‘;.-. I.E\}-.-.-.-.-.-.-.-.-_;::__-_-_-_-_-. -.-.-.-.-.-.-.-.-.-.-.-.-JI ‘;.-. LE1T TR -.-.-.-.-; Jeipilpetl
[ I T - 1 %H 0.00 &
R N PRl oo
___________ j%@"nf;' YAV S0 W (1
____________ %{. st PSS S - - - 7|
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1o 000 |~ :\: O s
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7. In the help geometry draw a polygon. The intersection points of the auxiliary

construction can now be captured easily.
DRAW function

N

Start at point P1 and draw until point P7.

LT A1 R _& ~

The curve is next: Use the [Tab] key to show the input assistant and select the function
CURVE OVER 3 POINTS.

Set P8 on the help line P9 on the end point
1 [ 1 I ] | [ | 1
T R T - [ -
1 1 (IR | /’ | | [ 1 /.—
N i g o R 7
------------ Rt RS
1 1 s e
P8 o BeES ¥ . ¢ fg N\ oo |
_____________ il 7 1 I -——————————--i;-L-L-f“ L e
____________ v Y U N S S . - S 17 )
[ " [ P \!F
by RS, I
TS B T e P . 5
AT e " R A e i
B | 1 | 1 | A /_"I ! : I : '\\

An external wall, a ceiling or a structure could now be created from this polygon.

8. To delete all help lines, select the function DELETE ALL HELP GEOMETRY.

&
Cecvigs@s (D

9. To remove the lines from the screen, open a new file.
O
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AUXILIARY LINES 2

Now the following example is to be constructed in which all functions from the first
part of the course unit are used.

Draw auxiliary lines to define the outline of the belt.

With the PARALLEL STRAIGHTS function, a vertical and horizontal auxiliary line
is always automatically placed through the origin of the CAD 0 point.

R 20

10°

R 20 /

Before starting to draw, various settings are made.
Scale 1: 1, units mm and format A4

60

1:1 = lmm - ||| Ad

ATTENTION: If auxiliary lines or auxiliary circles are already
available, NO lines are placed through the CAD 0 point.
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1. Create vertical guides with distance 60.

Tools v 3 x

Search jo.
Auxiliary-lines

I R I
A X F |+

&oEs o

2. Eigenschaftsleiste erganzen mit dem Abstand 60 und der Wiederholungen 1

= 7 - B B o—=
Ea | 60 - | o parallel auxiliary-lines with relative distance
L k=

3. Specify the point P1 to create the vertical parallel.

4. Now enter the distance 50 for the horizontal auxiliary line in the property bar and
set the point P2.

;;;1’I | 50 - I 2R parallel auxiliary-lines with relative distance
3 g
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AUXILIARY CIRCLES AND LINES

1. Erstellen der Hilfskreise mit Radius 20 und 10.

Toals v 7 ox
Search joi

Auxiliary-lines

¢ T

-'.’ '_.—ﬂ'. o F B
A

o e o
I-..»' e

2. Add the property bar with the radius 20

Lt eing
=7y:d 20 - g Circle with given centre and radius
& | ) g

2. Set the snap mode to AUTO SNAP and set the point P1. [+ Autosnap
3. Change the value for Radius on the property bar to 10 and set the point P2.

The intersection of the auxiliary line is automatically recognized by the
AUTO SNAP function. Just tap near the intersection point so that you
can see that the snap point is searched for automatically.
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4. Create the auxiliary line by specifying the angle.

Tools v R ox
Search £

Auxiliary-lines

ol X e E o

& oo

5. Add an angle value 40 to the property bar.

,:ﬂ | 40 - | P Straight with given angle by one point

6. Place the line on point P3.
7. Change the value for Angle on the property bar to 10 and set the point P4.

.
.
.
.
’
. .
. -
- Tty
14 B
7z 1 -
’ =t
<L
PR 2t BN
N [
_-_—— 7’ \
____________ g —______.f_____+__l__T_________________________
= 1 2 1
S . \ ’
R 1 ’ s~
5 -
1 o ~
I ’ I
.
1, 1
D2, |
L 1
el 1
1 \\ 1
-
1 0 \ !
s 1 3 1
/’ [} 1 [}
________ Locogrocodboocccccoogpo oo oo oo oo oo oo =
7 1 1 1
’ \ [}
’ \ U
’ 7 [}
. N p |
’ N P
7z S, - !
1
1
1
1
1

8. Now enter an auxiliary circle again, but this time with the CIRCLE BY RADIUS

function.
Tools v 3 x
Search jo

Auxiliary-lines

c Mo § 0 s

u . '_rﬂ'. .g,-'J_ = .|_ ‘\Ef_.'
A

IR SO
L-" e

9. Add a radius 20 to the property bar.

or | 20 - | Circle by radius
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10. Place the auxiliary circle by entering points P5 and P6.

10. Now the tangent between the two circles is determined.

Tools v 3 x
Search ,O‘
4 Auxiliary-lines

- . Pt
,:ﬂ oX ¥
@ 3 oF

11. Place the cursor at point P7 and point P8.

WORKSHOP END
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DELETE

For a better overview, now delete the auxiliary lines that are not required.

1. Click on the desired auxiliary line (it will turn purple) point P1, and remove it with

the [Del] key or with the icon 4 (delete). (With the [Shift] key a selection of several
auxiliary lines is possible). Now the dialog box appears with the query, Delete
selection? This is confirmed with Yes.

2. For the remaining auxiliary lines that are not required, proceed as described in point.
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So that when deleting the query Delete selection? does not appear and

you can therefore work more quickly, the following can be set.

SETTINGS — OPTIONS — WORK PARAMETERS — GENERAL
and then deactivate the button CONFIRM DELETE.

Options - Work parameters - General

-] System

[:| Save/Load

(-5 Work parameters

----- General

----- [ Drawing

----- [ Drawing (CAD-Start)
----- Edit

EE Geodesy

[ Reference plan/Layer
% Mechanics

----- A Mechanics lines
-] Depiction

-] Views

General

[ Work in parallel work planes
[]Hatch to contour model

[] Autom. text enlarging

Contour search | Branching at point

Corner with parallel contour
Delay with property list

Entry of text slant

Measure
Decimal places =
[ ] Extended OK

ID Confirm delete I

[] Text into new model

m ~

: Seconds
-'L"}‘ S

[ Preview area

Cancel Help
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DRAW

In the next step you will learn to draw out the auxiliary lines.

VVYYVY WORKSHOP

1. Select the function DRAW.

Tools v 7 ox

Search p

[ Auxiliary-lines
4 Elements

/nloome
ek R /A
oS &

Die Eigenschaftsleiste wird angezeigt.

2. Wihlen Sie den Linientyp "durchgehend" und die Farbauswahl ,,2* (rot) aus.
p|Ld .| | Polygon =

3. Enter points P1 - P8 using the auto snap. Pay attention to the correct cursor arrow
position for the circular arcs.

— TIPP
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At the beginning you can use the zoom command to enlarge situations
in order to better recognize the snhap points. Later, when there is more
routine, this is no longer necessary.

4. To end the line sequence, press the [Esc] key or select the CANCEL function o

5. Save work copy!

ROTATE, ZOOM AND MOVE THE SCREEN

Move the screen

Simultaneously hold down [Ctrl] + middle mouse button and move the mouse or,
while holding down the [Ctrl] key, use the arrow keys on the keyboard [(--)1«‘1‘].
Rotate the screen

If you just keep the middle mouse button pressed and move the mouse, you will turn
into 3D. In the 2D version this is not possible in the standard settings.
Moving the mouse causes the following movements on the screen.

Reset camera

# or [Ctrl] + [Space]

Select this function to return a rotated screen to its original position. Starting position
means "view normal to the work plane™ and "sheet format centered on screen™.

Zoom screen

Simultaneously hold down [ Shift] + middle mouse button and move the mouse up
and down. The picture is enlarged towards the top and reduced towards the bottom. If
you have a mouse with a scroll wheel, this wheel can be used to zoom. If you only
want to zoom in on the format (e.g .: A3), you can do this using the function

ZOOM ON FORMAT,

Pt dE@ QR &

Or ZOOM bz 2 POINTS, here you specify two points (P1, P2) over a diagonal. This
area is then zoomed and displayed on the screen.
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WORK COPY

The current stage of work is saved to a temporary directory. A work copy is stored
under the name "woco". A certain number of work copies can be made whereby the
oldest one in each case is removed and the new one becomes "woco_0".

A work copy is not to be used to save the final version of a project!

Save work copy

or with the key combination [Ctrl]+[W]
Load work copy
Opens the last work copy (woco_0).

To load the penultimate work copy or even older ones, select the function LOAD
WORK COPY in the FILE menu.
Menu FILE > LOAD WORK COPY

M| Load work copy

T <« EliteData » temp v | D O Search temp

Organise « New folder =- « [H 9
Mame Date modified Type Size "~
. woco Dl 27/08/2021 15:35 Elite Workfile 456 KB

. weoco 1wl 27 021 15:35 Elite Workfile 456 KB

. weoco 2wl 27/00/2021 15:34 Elite Werkfile 453 KB

Bl woco 3.l 27 021 15:34 Elite Workfile 451 KB

[ i A= aAnt 5. LERTTRRY=TN 11 vn M

File name: || w | Work copies (*.wfl) ~

Select the desired woco and click OPEN to import it into the CAD.

All of the settings in connection with work copies can be found in the options.
Menu SETTINGS > OPTIONS > SAVE/LOAD > DRAWING

Options - Save/Load - Drawing

= Syst
& a ystem X R Drawing
o] m Configuration
Q General Path for projects: D:\EliteData'\Projekte 15\de_at
.8 User interface
N & Region [ Include views in save [ Save textures as well
-4 Save/Load [JInclude radiosity in save
[l General Save background image as external reference
B
iR Interfaces Work copies
-] Work parameters Path for -
-] Depiction T | D:\EliteData\ternp
(-] Views
Mumber of work copies = [ with projectname
Mo automatic work copy ~
[ Extended oK Cancel Help
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MANIPULATE POLYGON

A created polygon can be modified. The 1st click on the polygon selects it and the
corners receive handles.
1st click 2nd click

A

The 2nd click decides which corner or which edge is modified. So that you can tell
that the cursor is over a changeable element, it changes its appearance to a quadruple
arrow.

Other manipulation functions appear depending on whether a line, a curve, a corner or
an end point was clicked. The function last selected is immediately active.

The available manipulation options appear in the Input assistant tool bar or on the
cursor with the [Tab] key.

Manipulation options on a corner
Stretch point Delete point

Chamfer Fillet

e
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Manipulation options on an edge
Insert point  Round edge  Stretch element

E

[ | — 4 J% /
o N
/ ¢
) /

Manipulation options for a corner or edge

Move selection Scale element

=

|
7 i
e
I
- T A

By pressing the [Ctrl] key at the same time, the selection can be copied when moved.
When scaling, a reference point must be set as the starting point for scaling.

Move elements parallel Move all edges parallel
______ |
|' ——
- | ;
]
| |
| | |
] | |
| I
- J
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Change polygon

A distinction is made between whether a closed or an open polygon is to be modified.
After you select the change function, the drawing functions with which the change can
be drawn appear in the Input assistant.

Expand/reduce closed polygon by one circle:
First select the Expand or reduce polygon function followed by the drawing function
Circle.

Drawing function Extend circle polygon Reduce polygon

& @ O @

% ; <& <
Nz

For the open polygon, the extension polygon must be started on the geometry and
ended by double-clicking on the geometry. An exception is when you start on an end
point. If the polygon cannot be closed properly, the change is not carried out.
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STRUCURE /| SELECTION

Selection of element part

For certain manipulations such as move selection or extend elements/move in parallel,
it makes sense to perform the manipulation not on the entire polygon but only on
certain elements.

To enable individual elements to be selected, the selection mode must be switched to
"Selection element part".

File: == ELITECAD - [Design modyd

File Edit View Insert Draw ME-Obj

O @ = 3
9 .lg @ ) ,’.é}
Tl m — M s

Alternatively, press the [Alt] key.
Multiple selection [Shift] key

Edit a rectangle until you receive the following result:

] \

1. Begin with entry of the rectangle. Function RECTANGLE

[

Set the first point of the rectangle at any point on the screen. For the second point,
press the [Tab] key and enter in the value field the x value 1000 and the y value 1000
and confirm your entry.

r ﬁ < 1000.00
|

1000

| = 130055

| <« 4359°
o

5g- - g

End the drawing function by pressing [Esc] or CANCEL.
D

e e
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2. The first manipulation function is the extension of a polygon.

Select the rectangle P1. Move the cursor to an element of the polygon until the
quadruple arrow appears. With one click P2 you activate the current manipulation
function in the input assistant. To display the selection of the function, press the [Tab]
key. Select the function REDUCE POLYGON.

a : g elEE @ NS
_.‘__'_
oy -
o1 Ez' e H:EE &
< 27000 T g
= IJ """"'("""I';l

RECTANGLE drawing function

ra—/f ol e
S ey

i
= noo 4
o 27000

[z

Pyl
B L a

Start point lies on the middle End point lies on the middle
of the element of the element

=1

|

L

(o]
e

L;M.'
AL

—
&
=

E
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3. Another manipulation option is the filleting or chamfering of a corner. In the
example the lower left corner is to be filleted.

e

Click in the corner [Tab] key, FILLET

e B NIRr o

e -734 46 -~ |

4
e

b g 1 0.00
E] I'J"Fll
Enter radius 400 Confirm

o
-/ \L;'

4. The next manipulation is stretching a point. The right lower point is to be moved
150 cm to the right.

Click in the corner [Tab] key, STRETCH POINT
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5. The upper edge must be stretched upwards by 500 cm.
Click on the edge [Tab] key, MOVE ELEMENTS PARALLEL

=309,

T 0.

= EIERE

< . 180.00 *
o

ﬁ Move elements parallel l
o

[

Move cursor to the perpendicular help line and enter the direct value 500 in the value
field.

6. The INSERT POINT function splits an element and enters a point that can be set at
the desired position straight away.

Click on the element Function INSERT POINT

pipYat=
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7. Until now the manipulations were performed on the entire polygon; now however
only one element can be selected. Before the element is selected, you must switch to
the selection mode element part.

i

Remove existing selection with the [Esc] key or by left-clicking into an empty space.

Mark element Click for manipulation mode

R

Function MOVE ELEMENTS PARALLEL

— EH'EQ

I 2872 T
T

=X

33045 1
99.04° 5

~—

Move the element out and move the cursor to the lower point until the catch symbol
point on the cursor appears. You can then be sure that the element is located
perpendicular above the point.

o

L

- 0.00
1 0.00
e 0.00

I1E 2C *

The same manipulation, but across the entire polygon, has the following result:

8. Open a new file and deactivate the selection mode element part.

O A
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SAVE

The first time you will save the drawing select the function SAVE AS under the FILE
menu.

1. Menu FILE > SAVE AS

W Proj:<CAD_Object_Terrain> Structi<|

File |[JEdit View Insert Draw {

[ Mew Ctri+N
& Open.. Ctrl=0
'

T Load wark copy...

Show...

B save Ctrl=5
Save as.. F12
| Save woark copy Ctrl=wW

Camd

With this save function, it is possible to save only the currently displayed
content. If the drawing is not fully displayed, the following message
appears.

Save drawing X

Parts of drawing are switched off!

I complete drawing I visible selection Cancel

With these options you can choose to save either the "complete drawing"
or only the "visible selection™. In most cases, however you will want to
save everything and not just the visible parts.

If the message appears in your example, select the option "Complete
drawing".
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2. In the field File name enter the name Model01 and save the model.

4| Save drawing

« v <« en_uk * Sample draw... v (W] O Search Sample drawings me...
Organise « MNew folder == - 9
CAD_Object3 " MName Date moedified
CAD_Objectd Bend 08:4
CAD_Object5 Cover plate 09:0
CAD_Objectb Kinematics 08:4
CAD_Objekt2 Samples-20 09:0
Sample drawings mechar 2amples-30 020
Spray head 08:4
Training fnes
Projekte v £ 3
File name:|| Modell1 w
Save as type: | ELITECAD files (*.d) ~
 Hide Folders Cancel

3. To check whether the file is saved, you quickly see a control text in the status line
(bottom left of the screen edge).

Pt EaFOEEPe
”

D:vhans4378\Documents\plate.d has been saved!

and the info balloon appears if it is activated.

ELITECAD - Info
file copy successfully

Load testing successfully ended
ELITECAD 15

4. End the program by selecting FILE > END from the menu

5. The program closes by itself.

When you end the program, the current setting on the complete drawing
is saved. The assignment of toolbars is then identical to the current one
when you switch on again.
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OPEN

1. Start ELITECAD.

2. Use “FILE > LOAD ...”

File: <>

=

ELITECAD - [Design me

File | Edit View Insert Draw ME-O
(9 mew ctri=N |
& Load. Ctrl+0
"'H
1 Load work copy... |
Shown.,
Recently loaded files b
Import ]
B save Ctrl+S

—LIT=CAD

3. Switch to your specified directory and open the drawing file.

I Load drawing

«— o

Organise *

1 <« en_uk * CAD_Ohbje.. »

Mew folder
CAD_Object_ProjectDl
CAD_Object_Realtime_Visualization
CAD_Object_Renovation_Planning
CAD_Object_Terrain
CAD_Object]

CAD_Object2
CAD_Object3
CAD_Objectd
CAD_Object5

TATE Ailie—bE

w ) o

File name:

- | ELITECAD files (*.d)

Search CAD_Object3

Cancel
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To view the contents of a file before open the drawing you can change
to large icons using the context menu or the icon right down.

WELITEY 1500, me\EN\Example drawings mechanics\Bend - O *
» EMN » Example drawings mechanics » Bend v | & 2 Search Bend
~
@
kr bohrung.d kr ergebnis.d kr flansch.d kr flansch k.d
[ iE . é
View > Extra large icons
Sort by > 1 ® Llargeicons
Group by > Medium icons
Refresh Small icons
Customise this folder... =
Details
Paste Tiles
Paste shortcut .
%% Send with Transfer..,
New > or
Properties
v
5

—LIT=CAD
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TRAINING EXAMPLES
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A corner can be rounded using the FILLET function (Modify menu —
Elements — Fillet).

|’_|v @20 5 Ausrunden
Fillet
(I

Indicates that the Fillet function is active. It is also possible to switch to
the functions NOTCH and CHAMFER.

Radius

()20

The radius with which a corner is rounded is specified in this field.
Modify

-

With this function you can change or remove already existing fillets. If
a fillet is to be deleted, the value 0 must be entered in the radius field.

www.elitecad.eu 49



—LIT=CAD

Version 15

c6l
4]

04

Pty

Olc

Ge

629

0S

gCh

0¢

ovl

o5

50

www.elitecad.eu



Version 15 —LIT=CAD

@32 30

N

32,5

85

37,5

www.elitecad.eu 51



Version 15 —LIT=CAD

-
-/

ol
oLl 7] I z61

200
260

www.elitecad.eu 52



Version 15 —LIT=CAD

l=q 20 -

10

www.elitecad.eu 53



Version 15 —LIT=CAD

\i&il\\\
\:\:1
N
m—
o) o o
o o) ~
14 ¥ o
] i
; L'Tf o
o D
— ™~
_________ ' o
™~
] 9
1 Ge

801

www.elitecad.eu 54



Version 15

38

www.elitecad.eu

820"
240

—LIT=CAD

61 [
RZ
e
,—//
20
55



Version 15 —LIT=CAD

6¢

+0.1
14 00,&

)
U/

(o]
=2 = L()
(0} 4% <
X
m \"
i 4P ] |
—
N
OO - =3 ”
ed/”“ — o
o
N
© M\ 4 ‘o
/ ~
/ b e
o
(o]

www.elitecad.eu 56



